Bai tap MOS Word 2016 theo Objectives

MOS WORD 2016

Objective 1. Create and manage documents

Part 1.1. Create documents

Create a blank document
Create a blank document using a template
Open a PDF in Word for editing

Insert text from a file or external source

# | Task Yéu ciu
1. | Start Word, and do the following: Mé& Word va thwe hién theo cac yéu cau sau:
a. Create a new document based on the built-in Blank a. Tao van ban méi dwa trén mau van ban trang (Blank)
document template. b. Lwu tai liéu trong thw muc thwc hanh véi tén
b. Save the document in the practice file folder as MyBlankDoc.docx
MyBlankDoc.docx.
2. | In the open document Trong van ban dang mo:
a. Create a document based on the Fax (Equity theme) | a. Tao van ban mai dwa trén mau Fax (Equity theme).
template. b. Lwu van ban trong thw muc bai tadp véi tén
b. Save the document in the practice file folder as MyFaxCover.docx.
MyFaxCover.docx.
3. | In File Explorer, navigate to the practice file folder, and do | Trong File Explorer, diéu huwéng dén thw muc tép thuc

the following:

a. Create a new document based on the Word_1-1a
document template.

b. Save the document in the practice file folder as
MySummerDoc.docx.

hanh va thwc hién:

a. Tao tai lieu moi dwa trén mau (Template) tai liéu
Word_1-1a.dotx.

b. Lwu tai liéu trong thw muc tép thwc hanh véi tén
MySummerDoc.docx.
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4. | Open the Word_1-1b text file in Word, and do following: M¢ file text Word_1-1b.txt trong Word
a. Select the text file title, Nursery Rhymes, and formatit | a. Chon ndi dung cé tiéu d& Nursery Rhymes va dinh dang
as bold. chir Bam.
b. Save a copy of the file in the practice file folder as b. Tao ban sao va lwu véi vao thw muc thye hanh véi tén
MyNurseryRhymes.docx to preserve the formatting. MyNurseryRhymes.docx gii dinh dang vira thye hién.
5. | Open PDF Word_1-1c.pdf, do the following: Mé& file PDF Word_1-1c bang Word
a. Modify the PDF file in Word by deleting the Technical a. M& file PDF trong Word bang va xoa doan van ban
Review paragraph from the last page of the file. Technical Review trong trang cudi.
b. Save the modified file in the practice file folder as a b. Lwu tép tin chinh stra trong thw muc bai tap voi tén
document named MyPDF.docx MyPDF.docx
6. | Inthe end of MyNurseryRhymes.docx, insert text from Cudi van ban MyNurseryRhymes.docx, chén néi dung

file Word_1-1b.txt

chi¥ tr tép tin Word_1-1b.txt

Part 1.2. Navigate through documents

Search for text

Insert hyperlinks

Create bookmarks

Move to a specific location or object in.a document

Open the Word_1-2 document, and then do the following:

#

Task

Yéu cau

7.

a. Search all instances of toy. Move between the search
results by using the navigation buttons on the Results
page.

b. Modify the search options to locate only instances of the
capitalized word Toymakers.

a. Tim t4t ca cac thé hién cua toy. Di chuyén gilra cac két
qué tim kiém bang cach sir dung cac nuat Iénh diéu
hwdng trong trang Result.

b. Chinh stra lai lwa chon tim kiém sao cho chi tim cac thé
hién cua Toymakers c6 chir T hoa.
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c. Perform an advanced search for all instances of Toy or
toy, either capitalized or lowercase that have the
Heading 2 style applied.

c. Tim tit ca cac thé hién cta Toy hoac toy, ca chir hoa va
chir thwdng ma c6 ap dung style Heading 2.

8. | Display the table of contents, and then do the following: Dén phan muc luc (table of contents) va thuc hién yéu cau
a. Insert a hyperlink from each of the six first-level headings | Sau:
in the table of contents to the corresponding heading in | a. Chén siéu lién két hyperlink cho néi dung sau tiéu dé cap
the document. d4u tién trong muc luc d& chuyén tdi cac doan van ban
b. Move to the Resources section of the document, and c6 tiéu dé twong wng trong tai liéu.
do the following: In the first paragraph, insert a b. Di chuyén t&i phan (section) Resource ctia van ban,
hyperlink from the URL wingtiptoys.com to the chén siéu lién két cho dia chi wingtiptoys.com chuyén
website at http://www.wingtiptoys.com. Change the t&i trang http://www.wingtiptoys.com. Thay doéi chi
display text of the hyperlink from wingtiptoys.com to the hién thi cia lién két tir wingtiptoys.com thanh the
Wingtip Toys website. Wingtip Toys website.
9. | Inthe Contact Us section of the page, do the following: Trong phan Contact Us cla trang, thwc hién cac yéu cau:
a. Insert a hyperlink from sarah@wingtiptoys.com that a. Chén siéu lién két cho sarah@wingtiptoys.com sao
will create an email message addressed cho sé tao email gl toi dia chi
sarah@wingtiptoys.com, with the subject MOS Study sarah@wingtiptoys.com v&i tiéu d&@ MOS Study Guide
Guide message. Ensure that the display text remains message. Chu y chir hién thi sé& I3
sarah@wingtiptoys.com. sarah@wingtiptoys.com
b. Select the name Lola Jacobsen and insert a bookmark | . Chon tén Lola Jacobsen va chén danh dau (bookmark)
named SalesManager. _ vGi tén SalesManager.
c. Select the name Lola Jacobsen and insert a bookmark c. Thém danh d4u co tén DesignManager cho tén Sarah
named DesignManager Jones
10. | Return to the beginning of the document and then use Go | Quay tré vé phan dau cua tai liéu va sir dung chirc ndng Go

to function to do the following:
a. Move between graphics in the document until you reach
the end.

a. Move from the last graphic to the top of page 3
b. Move from the top of page 3 to SalesManager bookmark

to dé thuc hién:

c. Di chuyén gitra cac doi twong graphic trong tai liéu cho
t&i khi téi graphic cudi cung.

d. Di chuyén tir graphic cudi cung d6 téi dau trang 3

e. Di chuyén tr dau trang 3 t&i bookmark SalesManager
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Part 1.3. Format documents
- Modify page setup
- Apply document themes
- Apply document style sets
- Insert headers and footers
- Insert page numbers
- Format page background elements
Open the Word_1-3 document, and then do the following:

# Task

Yéu cau

11. Turn on automatic hyphenation
Apply the Facet theme to the document.
c. Change the color set to the Red Orange palette, and

change the font set to Corbel.

oo

. Bat chirc nang gach ndi tw déng (hyphenation)
b. Ap dung chi dé (theme) Facet cho tai liéu.
c. Thay dbi bd mau la Red Orange va thay dbi bod font chi

thanh Corbel

12. | a. On page 2, add a Facet (Even Page) header and the
Circle, Right page number in the right margin.

b. Add a diagonal watermark that displays the text
Example Only to the page background. Format the text
of the watermark as semitransparent 54-point orange
(Accent 4) text.

c. Apply style set Casual to the document.

. Trong trang 2, thém tiéu dé dau trang (header) kiéu

Facet (Even Page), thém sé trang (page number) kiéu
Circle, Right dat bén lé trang.

. Thém chir nén md (watermark) hién thi chir Example

Only. Dinh dang chi*r m& kiéu semitransparent, 54pt,
mau Orange, Accent 4.

. Ap dung bo style (style set) Casual cho tai liéu

Part 1.4. Customize document options and views

- Change document views

- Customize views by using zoom settings
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Customize the Quick Access toolbar
Split the window
Add document properties

Show or hide formatting symbols

Open the Word_1-4 document, and do the following:

#

Task

Yéu cau

13.

a. Display two pages of the document side by side in Print
Layout view.

b. Split the window, and display the document view in the
upper split pane at 235% and the document view in the
lower split pane at 45%.

c. Close the lower split pane, and display the document at
page width.

a. Hién thj hai trang cGa van ban canh nhau trong ché do
Print Layout

b. Chia ctra sb (Split) va hién thi ctra sd bén trén phéng to
235% va clra sO bén dudi thu nhé vé 45%

c. Doéng clra s6 bén dwai va hién thj van ban dang page
width

14.

Display the Quick Access Toolbar page of the Word

Options dialog box, and do the following:

a. Create a Quick Access Toolbar that appears only in this
document.

b. Add the Format Painter button, the Shading button, and
the More Shading Colors button from the Home tab to
the document-specific Quick Access Toolbar.

c. Add the Insert Comment button and the Accept menu
from the Review tab to the document-specific Quick
Access Toolbar.

d. Insert a separator between the three commands from the
Home tab and the two commands from the Review tab.

Hién thi trang Quick Access Toolbar ctia hdp thoai Word

Options va thuwc hién cac yéu ciu sau:

a. Tao thanh truy cap nhanh (Quick Access Toolbar) chi
cho tai liéu hién tai

b. Thém nut Format Painter, Shading va More Shading
Colors trong tab Home vao thanh truy cap nhanh cho tai
liéu cu thé nay.

c. Thém nut Insert Comment va Accept trong tab Review
vao thanh truy cap nhanh cho tai liéu cu thé nay.

d. Chén dau phan céch gitra ba 1énh tir tab Home va hai
|énh tir tab Review.

15.

Display the Customize Ribbon page of the Word Options
dialog box, and do the following:

a. Display the Developer tab on the ribbon.

Hién thi trang Customize Ribbon clia hép thoai Word
Options va thyc hién:
a. Hién thj tab Developer
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b. Hide the Mailings tab.

c. Create a custom tab named Favorites with a custom
group named Colors. Assign a symbol of your choice to
the group.

d. Move the Proofing group of commands from the Review
tab to your Favorites tab.

e. Add the Font Color and Text Highlight Color buttons
to the Colors group

b. An tab Mailings

c. Tao moét thé (tab) tay chinh co tén Favorites voi mot
nhém tuy chinh c6 tén Colors. Gan mét bieu twgng ban
chon cho nhém.

d. Di chuyén nhém lénh Proofing tir tab Review sang tab
Favorites cta ban.

e. Thém cac nut Font Color va Text Highlight Color vao
nhom Colors

16.

Change the document properties:

a. Set the Title property to Simple Room Design and the
Subject property to Room Planner.

b. Assign the keywords redecorating, color, and style to

the document

Add yourself as the only author.

Add a custom property named Document Number with a

value of 1001.

oo

Thay dbi thudc tinh tai liéu (document properties):

a. Thém thubc tinh tiéu d‘é,(TitIe) thanh Simple Room
Design va thudc tinh dbéi twong (Subject) |a Room
Planner.

b. Thém tr khoa cho tai liéu (keywords) la redecorating,
color va style

c. Thém ban la tac gia duy nhét.
d. Thém thudc tinh tuy chinh cé tén Document Number vé&i
gia tri 1001.

17.

Check spelling the document and show all the formatting
marks.

Kiém tra chinh ta cla tai liéu va hién thj tat cac dau dinh
dang (formatting marks).

Part 1.5. Print and save documents

Modify print settings
Save documents in alternative file formats

Print all or part of a document

Inspect a document for hidden properties or personal information
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- Inspect a document for accessibility issues

- Inspect a document for compatibility issues

#

Task

Yéu cau

18.

Open the Word_1-5 document, review its content, and then
do the following:

a. Print only Section 1 of the document, with the scaling set
to 2 Pages Per Sheet.

b. Save a copy of the document in the practice file folder as
a PDF file named MyBookmarks that is optimized for
online publishing and includes bookmarks to all the
document headings.

c. Save a copy of the document in the practice file folder as
a file named MyCompatible that is compatible with Word
2003.

Mo tai lieu Word_1-5, xem qua ndi dung va thyc hién cac

yéu cau sau:

a. Chiin section 1 cla tai liéu véi thiét 1ap in 2 trang trong
1 t& (2 Pages Per Sheet)

b. Lwu mot ban sao van ban dw¢i dang PDF véi tén
MyBookmarks trong thw muc bai tap véi viéc téi wu cho
xuat ban trwc tuyén (optimized for online publishing) bao
gdm ca bookmark cho céac tiéu dé (Create bookmark
using Headings)

c. Lwu mét ban sao van ban trong thw muc bai tap voi tén
MyCompatible ma twong thich véi Word 2003.

19.

From File Explorer, do the following:

a. Open the MyBookmarks file in a PDF reading program
(such as Microsoft Reader), display the bookmarks, and
verify that clicking bookmarks moves to the
corresponding headings.

b. Open the MyCompatible document in Word 2016,
ensure that Compatibility Mode appears in the title bar,
and review the document to identify any changes
resulting from the file compatibility downgrade.

Tw File Explorer, hday thwc hién:

a. M& tép MyBookmarks trong chwong trinh doc PDF
(chang han nhu Microsoft Reader), hién thj cac dau trang
va xac minh rang viéc nhap vao d4u trang sé di chuyén
dén céc tiéu dé twong tng.

b. Mé& tai liéu MyCompatible twong thich trong Word 2016,
dam bao rang Compatibility Mode xuét hién trén thanh
tiéu dé va xem xét tai liéu dé xac dinh bat ky thay déi nao
do viéc ha cap kha nang twong thich cla tép.

20.

Check hidden properties or personal information and
remove these properties.

Kiém tra cac thudc tinh tai liéu va théng tin ca nhan va loai
bé tat ca cac thc tinh nay.
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Objective 2. Format text, paragraphs, and sections

Part 2.1. Insert text and paragraphs

- Find and replace text

- Cut, copy and paste text

- Replace text by using AutoCorrect

- Insert special characters

# |Task Yéu cau
21. | Open the Word_2-1a document and do the following: M& tai liéu Word_2-1a va thuwc hién
a. In the first paragraph, insert the registered trademark | a. Trong doan dau tién chén biéu twong nhan hiéu
symbol (®) after the word Microsoft. trademark ® ngay sau tv Microsoft
b. Replace all instances of (trademark) in the document | b. Thay thé tat ca thé hién clha (trademark) trong tai liéu
with Paragraph character () with font size 30 and red thanh bieu twong (1)) voi font chlr 30 va mau chi» Red.
font color. Ensure that you replace only instances in Chac chan rang ban chi thay nhirng tir trademark nam
which the word trademark is in parentheses, and no trong dau ngoac don va cac tir khac thi khéng.
other version of the word.
22. | Open the Word_2-1b presentation in PowerPoint and do | M& ban file Word_2-1b trong PowerPoint va thic hién nhw

the following:

a. In the left pane, click the Slide 4 thumbnail. Use any
technique to copy Slide 4 to the Clipboard.

b. Return to the Word_2-1a document and do the
following: Display the Clipboard pane and verify that the
copied slide is the most recent item on the Clipboard.

c. In the second paragraph, replace the text <link to slide
here> with a linked copy of Slide 4, as a PowerPoint
Slide Object. Save the document, but don’t close it.

sau:

a. Trong ngan bén trai, nhap vao Slide 4. S&r dung bat ky
ky thuat nao dé sao chép Slide 4 vao Clipboard.

b. Quay lai tai liéu Word_2-1a va thyc hién nhw sau: Hién
thj ngan Clipboard va xac minh rang trang chiéu da sao
chép la muc gan day nhét trén Clipboard.

c. Trong doan hai, thay thé van ban <link to slide here>
bang ban sao duoc lién két cua Slide 4, duéi dang
PowerPoint Slide Object. Lwu nhwng khéng dong file.
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d. Inthe Word_2-1b presentation, with Slide 4 active, click
the slide header and change an expert to a superstar.
Save and close the Word 2-1b presentation.

e. Return to the Word_2-1a document and do the
following: Update the link to the slide, and verify that the
document displays the most recent slide content.

f. Move to the end of the document, and append the

contents of the Word_2-1c document. Review the
complete document content.

d. Trong ban trinh chiéu Word_2-1b, tai trang Slide 4 dang
hoat ddng, hay bam vao tiéu dé trang slide va thay déi la
an expert to a superstar. Lwu va dong file Word 2-1b.

e. Quay lai tai liéu Word_2-1a va thwc hién: Cap nhat lién
két dén trang chiéu va xac minh rang tai liéu hién thj noi
dung trang chiéu gan day nhét.

f. Di chuyén dén cubi tai liéu va thém ndi dung cua tai liéu
Word_2-1c vao. Xem lai ndi dung tai liéu hoan chinh.

Part 2.2. Format text and paragraphs

Format Text and Paragraphs

Apply font formatting

Apply formatting by using Format Painter

Set line and paragraph spacing and indentation
Clear formatting

Apply a text highlight color to text selections
Apply built-in styles to text

Change text to WordArt

Open the Word_2-2 document va thwc hién:
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# | Task Yéu ciu
23. | Display the Navigation pane and the Styles pane, and do Hién thi thanh Navigation va thanh Styles thuwc hién
the following: a. Tw thanh Styles, chon tat c& cac doan dwoc ap dung
a. From the Styles pane, select all paragraphs that are style Heading 3, ap dung style Heading 2 cho cac doan
formatted as Heading 3, apply the Heading 2 style to the van ban dwoc chon.
selected paragraphs. b. Ap dung style Heading 1 cho tiéu dé& Financial
b. Apply the Heading 1 style to the Financial Summary Summary
heading. c. S dung Format Painter sao chép style cla tiéu dé
c. Use the Format Painter to copy the style from the Financial Summary cho tiéu dé Financial Statements
Financial Summary heading to the Financial va Statement Notes.
Statements and Statement Notes headings.
24. | Move to the beginning of the document, and do the | Di chuyén dén dau van ban va thyc hién:
following: a. Thiét lap khoang cach doan cho toan bd van ban la
a. Set the paragraph spacing for the entire document to Relaxed
Relaxed. b. Ngay sau tiéu dé clia tai liéu, chon chir A Brief Review
b. Immediately after the document title, select the text A of Our Finances va dinh dang doi twong la WordArt sty
Brief Review of Our Finances and format it as a dung mau cé san bat ky.
WordArt object, using a built-in style of your choice
25. | With the WordArt object selected, do the following. V&i WordArt vira tao, thwe hién:

a. Setthe Text Fill color to Brown, Text 2.
b. Set the Text Outline color to Orange, Accent 1.

c. Set the Reflection effect to Tight Reflection:
Touching.

d. Remove any Shadow, Glow, Bevel, or 3-D Rotation
effects.

e. Apply the Triangle: Down transform (in the Warp
category).

f. Set the width of the WordArt object to 4”.

a. Mau chir Text Fill la Brown, Text 2

b. Mau dwdng vién chir (Text Outline): Orange, Accent 1

c. Hiéu ng Reflection Tight Reflection: Touching

d. X6a cac hiéu &rng Shadow, Glow, Bevel, hoac 3-D
Rotation

e. Ap dung kiéu udn lwon (transform) Triangle: Down
(trong muc Warp)

f. Thiét lap d6 réng cua WordArt |a 4”
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g.

Set the text wrapping to Top and Bottom, and then
center the WordArt object on the page, between the title
and the Financial Summary heading

g.

Chon kiéu ngat chiv (text wrapping) dang Top and
Bottom, sau do can gitba WordArt trén trang, nam gitra
tiéu de va Financial Summary

Part 2.3. Order and group text and paragraphs

- Format text in multiple columns

- Insert page, section, or column breaks

- Change page setup options for a section

Open the Word_2-3 document, and do the following:

# |Task Yéu ciu
26. | a. Onthefirst page, insert a page break before the Process | a. Trong trang dau tién, chén ngat trang trwdc tiéu dé
heading. Process
b. In the Pre-Plan Project section, select the heading, the | b. Trong muc Pre-Plan Project, chon tiéu dé, doan van ban
paragraph, and the list items. Format each of the va danh sach. Dinh dang cac doan dwoc chon & trong
selected paragraphs to stay on the same page as the cung trang véi doan phia sau no, va gilr tat ca cac dong
paragraph that follows it, and to keep all the lines of the trong doan luén cung nhau.
paragraph together. c. Chon tieu d& Questions for Team Leaders va
c. Select the Questions for Team Leaders and Questions for Department Reps va danh sach phia
Questions for Department Reps headings and the lists sau 2 doan. Dinh dang thanh 2 c6t cé do réng bang nhau.
that follow them. Format the selection in two columns of Thiét 1ap khodng cach gitra 2 cot 14 0.3” véi duwong ké
equal width. Set the space between the columns to 0.3" gitra 2 cot.
and place a vertical line between the columns. d. Chén ngat cot trwdc tiéu dé Questions for Department
d. Insert column break before Questions for Department Reps sao cho mdi danh sach & trén mét cot.
Reps heading so each list in a separate column side. e. Gan cubi van ban, muc Carry out project. Tao phan
e. Near the end of the document, locate the Carry out (section) riéng chi chra ndi dung Carry out project

project section. Create a separate document section
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that contains only the content of the Carry out project
section, on its own page. For only this section, set the
orientation to Landscape and all four margins to 2”.

trong trang. V&i section nay, thiét 1ap hwdng trang ngang
Landscape v&i bon 1€ |a 2”

Objective 3. Create tables and lists

Part 3.1. Create tables

Convert text to tables

Convert tables to text

Create a table by specifying rows and columns
Apply table styles

Open the Word_3-1 document, and do the following:

#

Task

Yéu cau

27.

a. In the Consultation Request section, convert the

paragraphs that follow the heading into a page-width
table with five equal-width columns.

. Inthe Mileage section, convert the tabbed list into a table

that has two columns and six rows. Ensure that each
column exactly fits its contents.

. Apply the Grid Table 4 — Accent 1 built-in table style to

the table. Configure the table style options to emphasize
the header row and to have banded columns. (Clear
all other check boxes.)

. In the Consultation section, convert the table to a

tabbed list.

. In the blank paragraph below the Estimate heading,

insert an empty table that is three columns wide and four

a.

Trong phan Consultation Request, ghuyén doan van
ban sau tiéu dé thanh bang cé 5 cot bang nhau véi kich
thwdc bang vira voi kich thwéce trang (page-width).

. Trong phan Mileage, chuyén danh sach dwoc phan tach

b&i diu tab thanh bang gébm 2 cdt 6 dong. Chac chan
rang mdi cdt co dod rong vira véi ndi dung trong cot (auto
fit contents).

Ap dung dinh dang bang (table style) Grid Table 4 -
Accent 1 cho bang vira tao. Thiét Iap tuy chon cho bang
dé nhan manh dong tiéu dé (header row) va c6 mau séc
khac nhau gitra cac cot (banded columns). (X6a tat ca
cac tich chon cua cac lwa chon khac).

. Trong phan Consultation, chuyén bang thanh danh

sach dwoc phan tach béi diu tab.
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rows high, with each column exactly 1.5” wide. Apply the
List Table 5 Dark — Accent 1 built-in table style to the
table, with the default table style options.

Before Estimate heading, insert file Word_3-1b.xlsx

e.

Trong doan van ban trang duoi tiéu dé Estimate, chén
bang trang gom 3 c6t va 4 dong voi do rong cac cot la
1.5”. Ap dung dinh dang bang List Table 5 Dark —
Accent 1.

Trudc tiéu dé Estimate chén tép tin Word_3-1b.xlsx

Part 3.2. Modify tables

Sort table data
Configure cell margins and spacing

Merge and split cells

Resize tables, rows, and columns
Split tables
Configure a repeating row header

Open the Word_3-2 document, and do the following:

# | Task Yéu cau
28. | a. In the Customer List section, delete the ID column from | a. Trong phan Customer List, x6a cot ID trong bang.
the table.
b. Perform a nested sort to sort the table in ascending order | b. Thiét 1ap sap xép Iong trong bang voi State tang dan,
by State, then by City, and then by Last Name. sau do dén cot City, va cudi cung la Last Name.
c. Delete all rows that contain contacts located in Boston, | c. Xoa tit ca cac dong chira dia chi & Boston, MA.
MA.
d. Add two blank columns to the right side of the table. In | 4. Thém hai cot trdng bén phai ctia bang. Trong dong tiéu
the header row, enter Date at the top of the first column dé, nhap Date vao cot dau, Time vao cot thi 2
and Time at the top of the second column.
e. Adc_i a blank row to the top of the table. Ir_1 the table style | . Tham mot dong trdng vao dAu bang. Trong style options,
options, turn off the Header Row formatting. tit Header Row.
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In the blank row, merge the cells above the Last Name,
First Name, Address, City, and State columns into one
cell. Enter Customer in the merged cell.

. In the same row, merge the cells above the Date and

Time columns. Enter Appointment in the merged cell.

. Select the top two rows of the table. Format the text as

bold, and center the text horizontally and vertically
within the cells.

Change the width of the table to 100 Percent of the page
width.

Select the table rows that contain customer information.
Set the height of the rows to 0.4” and the cell alignment
to Align Center Left.

. Scroll to page 2 of the document, which now contains

several rows of the table. Configure the table to repeat
the Customer/Appointment header row at the top of the
second page.

Trong dong tréng, trén 6 phia trén cac cot Last Name,
First Name, Address, City va State thanh mot 6. Nhap
Customer vao 06 tron.

. Trong dong cung dong 6 trén, trén cac 6 trén cot Date va

Time. Nhap Appointment vao 6 gép.

. Chon 2 dong dau tién trong bang. Binh dang chir dam

va can gilra chi¥ theo chiéu ngang va doc trong 6.
Thay déi d6 rong ciia bang bang 100% vé&i do réng trang.

Chon cac dong trong bang chira thong tin khach hang.
Thay doi chiéu cao cac dong thanh 0.4” va can |€ 0 la
Align Center Left.

. Sang trang 2 cua tai liéu, thiét lap 1ap lai dong tiéu dé &

trang 2 phan Customer va Appointment

Part 3.3. Create and modify lists

Create a numbered or bulleted list

Change bullet characters or number formats for a list level
Define a custom bullet character or number format
Increase or decrease list levels

Restart or continue list numbering

Set starting number value

In the Word 3-3 document
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# Task

Yéu cau

29. | a. In the Characters of a Hit Fantasy section, format the
four paragraphs as a bulleted list that uses the standard

bullet character (o).

symbol of your choice from the Wingdings font.

diamond character ().

b. In the sections titled The Hero and The Teacher, format
the paragraphs as bulleted lists that uses a custom bullet

c. In the Plot Elements of a Hit Fantasy section, format
the three paragraphs as a bulleted list that uses the four-

a.

Trong phan Characters of a Hit Fantasy, dinh dang bén
doan thanh hoa thj str dung ky tw hoa thi (e).

Trong phan c6 tiéu dé The Hero va The Teacher, dinh
dang cac doan kiéu hoa thj str dung ky hiéu bat ky trong
font chir Wingdings.

Trong phan Plot Elements of a Hit Fantasy, dinh dang
ba doan thanh dang hoa thi hinh bén vién kim cuwong

(0:0)_

30. | In the section titled The Sequence of Events, do the

following:

the list, and change it to a second-level list.

the square bullet character (H).

a. Format the four paragraphs below the heading as a
numbered list that uses the A. B. C. number format.

b. Paste a copy of the list into the last blank paragraph of
the document, and restart the list numbering. Change the
number format of the second list to the 1) 2) 3) format.

c. Immediately below the second list, paste another copy of

d. Change the second-level list to a bulleted list that uses

Trong phén cé tieu dé The Sequence of Events, thuc hién
cac yéu cau:

a.

b.

Binh dang bon doan sau tiéu dé dang danh sach so sk
dung dinh kiéu A. B. C.

Sao chép danh sach nay dan vao doan trang cudi cling
trong tai Iié’u va danh lai s0 ciia danh sach. Thay doi dinh
dang vé kiéu 1) 2) 3)

Ngay sau danh sach thr hai, dan mét danh sach khac
va thay doi thanh danh sach cap 2 (Level 2).

Thay dbi danh sach cip 2 nay thanh dang hoa thi dang
hinh vuéng(M)

Objective 4. Create and manage references

Part 4.1. Create and manage reference markers

- Insert footnotes and endnotes

- Modify footnote and endnote properties
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Create bibliography citation sources

Modify bibliography citation sources

Insert citations for bibliographies

Insert figure and table captions

Modify caption properties

Open the Word_4-1 document

#

Task

Yéu cau

31.

b.

g.

In the About the Brothers Grimm section, do the following:
a.

Immediately after the name Jacob, insert an endnote that
says Jacob Grimm lived from 1785-1863.

Immediately after the name Wilhelm, insert an endnote
that says Wilhelm Grimm lived from 1786-1859.

After the name Hanau, insert a footnote that says Hanau
is located near Frankfurt, in the German state of
Hesse.

. Modify the footnote location so that it appears immediately

below the text on page 1.

Convert the two endnotes to footnotes, either individually
or at the same time.

Change the footnote numbering format to the range of
symbols.

Reposition the footnotes at the bottom of the page.

Trong phan About the Brothers Grimm thuc hién:

a. Ngay sau tén Jacob, chen endnote c6 ndi dung Jacob
Grimm lived from 1785-1863.

b. Ngay sau tén Wilhelm, chén endnote c6 ndi dung
Wilhelm Grimm lived from 1786-1859.

c. Ngay sau tén Hanau, chén footnote cé ndéi dung Hanau
is located near Frankfurt, in the German state of
Hesse.

d. Chinh stra vi tri footnote dé bi xuat hién & dwdi van ban
trong trang 1.
e. Chuyén hai endnote thanh footnotes.

f. Thay dbi dinh dang s6 cho footnote kiéu biéu twong

g. Thay déi dé dat vi tri footnotes dat tai cudi trang.

32.

Return to the beginning of the document and do the following:
a.

Position the cursor at the end of the first paragraph after
the About the Brothers Grimm heading. Create a

Chuyén dén dau trang va thuc hién:

a. Dat con tr6 cudi doan dau tién sau tiéu dé About the
Brothers Grimm. Tao mét vj tri (placeholder) d& nguén
tham khao (bibliography) v&i tén GrimmData
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bibliography source placeholder with the name
GrimmData.

b. Edit the placeholder to create a bibliography source that
cites the online article at
https://en.wikipedia.org/wiki/Brothers_Grimm. Use

the Document from Web Site source type. Leave the
author blank but complete the remaining required fields,
using the current date.

c. Display the Source Manager and verify that the Current
List contains the source you created.

b. Chinh sira vi tri dat dé tao ngudn tham khao tham chiéu
dén bai bao trwc tuyén trén trang web cé dia chi
https://len.wikipedia.org/wiki/Brothers_Grimm
St dung kiéu tai liéu |1a Web Site. Muc tac gia bo trong
nhwng nhap cac théng tin yéu cau str dung ngay hién
tai.

c. Hién thi Source Manager va kiém tra phan Current
List chira tai liéu tham khao ban vira nhap.

33.

Locate the first graphic, and do the following:

a. Caption the graphic as Figure 1. Man sleeping under
apple tree, with the caption below the graphic.

b. If text from the next paragraph comes between the graphic

and the caption, select the caption container and move it
upward so that it clears the text.

Chuyén dén hinh anh dau tién va thwc hién:

a. Thém mé ta (caption) cho hinh c6 dang Figure 1. Man
sleeping under apple tree, v&i [0 m6 ta dat dwdi anh.

b. Néu van ban tir doan tiép theo nam gitka hinh anh va
caption, hay chon vung chira caption va di chuyéen né
|én trén van ban.

34.

Locate the second graphic, and do the following:

a. Caption the graphic as Figure 2. The fox, with the caption
located above the graphic.

b. Resize the caption container to remove the extra white
space that blocks the graphic.

Chon hinh thr 2 va thwc hién:

a. Thém I&i mb ta (caption) cho hinh Figure 2. The fox,
vOi &I mo ta dat trén anh.

b. Chinh lai kich thwéc hdp chira dé x6a bd khoang tréng
bén trong hdp.
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35.

Locate the third graphic, and do the following:
a. Caption the graphic as Figure 3. Golden bird in a cage,
with the caption above the graphic.

b. Widen the caption container to fit the entire caption on one
line.

c. Resize the caption container to remove the extra white
space that blocks the graphic.

Chon hinh th&r 3 va thwe hién:

a. Thém I&6i mé ta (caption) cho hinh Figure 3. Golden
bird in a cage, v&i I&i mo6 ta dat trén anh.

b. Chinh réng hép chira sao cho & mé ta& nam trén mot
dong

c. Chinh lai kich thwéc ctia hop dé loai bd khoang tréng
trong hop

Part 4.2. Create and manage simple references

Insert a standard table of contents

- Update a table of contents

- Insert a cover page

# | Task Yéu cau
36. | Open the Word_4-2a document, do the following: M& tép tin Word_4-2a, thuc hién theo cac yéu cau:

a. In the blank paragraph after the title (Office |a. Trong doan van ban trdng sau tiéu dé Office
Procedures), insert a table of contents that uses the Procedures, chén muc lyc (table of contents) s dung
built-in Automatic Table 1 style. Take the necessary style Automatic Table 1. Thiét Iap mét s6 bwdc can thiét
steps to ensure that the page numbers in the table of dé chac chan rang so trang trong bang twong &ng voi
contents are correct after the TOC is inserted. muc luc da chén.

b. Insert a Facet cover page. On the cover page, replace | b. Chen trang bia Facet (cover page). Trong trang bia thay
the Document Title property placeholder with Office thé thuéc tinh Document Title thanh Office
Procedures. Procedures.

37. | Open the Word_4-2b document, do following: Mé tai liéu Word_4-2b thuwc hién theo cac yéu cau:

a. Remove the cover page.

b. Change the page size of the whole document to 5.5” x
8.5”, which might be named Statement or Half Letter

a. Xba trang bia
b. Thay ddi khd gidy cho toan b tai ligu thanh 5.5” x 8.5”
co tén |a Statement hoac Half Letter. Néu kich thuéc
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depending on your printer. If this page size doesn’t
appear in your Size list, you can create it as a custom
page size.

c. Return to the beginning of the document, and do the
following:

- Update the table of contents.

- Verify that the page number of the last heading in the
table of contents matches the page number of the
heading.

trang nay khong cé trong danh sach Size, ban co thé
chon kiéu kich thuéc trang tuy chinh (Custom size)

c. Quay tr& vé dau van ban va thwc hién:
- Cép nhat muc luc (table of cqnter]ts) ]
- Kiém tra s0 trang cua tiéu dé cudi twong rng v&i so
trang trong néi dung.

Objective 5. Insert and format graphic elements

Part 5.1. Insert graphic elements

Insert shapes

Insert pictures

Insert a screen shot or screen clipping
Insert text boxes

Open the Word_5-1a document, and do the following:

# | Task Yéu cau

38. | Position the cursor in the blank, centered paragraph after | Bat con tré & vi tri tréng, can gilra sau doan dau tién. Chén
the first paragraph of text. Insert the Word_5-1b picture | anh Word_5-1b trong thu muc luyén tap.
from the practice file folder.

39. | Position the cursor at the beginning of the fourth paragraph | Dt con tré tai vi tri bat dau cla doan tht 4 (sau trich dan

of text (after the first quote), and do the following:
a. Insert an lon Quote (Dark) text box in its default location.

dau tién) va thwc hién:
a. Chén hoép van ban lon Quote (Dark) tai vi tri mac dinh
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b. From the beginning of the eighth paragraph of the
document text, copy the sentence “And when the
princess opened the door the frog came in, and slept
upon her pillow as before, till the morning broke.”

c. Inthe text box, select the quote placeholder and replace
it with the copied sentence, merging the formatting.

d. Then delete the [Cite your source here] placeholder.

b. Tw vi tri bat du cla doan tdm cta van ban, sao chép
cau “And when the princess opened the door the frog
came in, and slept upon her pillow as before, till the
morning broke.”

c. Trong hép chi¥, chon trich doan va thay bang doan da
sao chép va ghép dinh dang (merging the formatting).

d. Sau do, xbéa hdp [Cite your source here].

40.

Move to the end of the document and do the following:

a. Insert a Scroll: Horizontal shape (from the Stars and
Banners category) of the default size.
b. In the shape, insert the text The End!

Di chuyén dén cudi van ban va thyc hién:

a. Chén hinh Scroll: Horizontal (t* nhém Stars and
Banners) voi kich thwédc mac dinh

b. Trong hinh khéi nay, thém chi* The End!

Part 5.2. Format graphic elements

Format Graphic Elements

Apply artistic effects

Apply picture effects

Remove picture backgrounds

Format objects

Apply a picture style

Wrap text around objects

Position objects

Add alternative text to objects for accessibility

Open the Word_5-2 document

#

Task

Yéu cau
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41. | On the first page, do the following: Thuwc hién cac yéu cau sau trén trang dau tién:

a. Apply the Metal Oval picture style to the picture. a. Ap dung style cho anh kiéu Metal Oval

b. Resize the picture so that it is 2.5” wide and maintain the | b. Thay déi kich thwéc anh sao cho chiéu réng la 2.5” va
original aspect ratio. gilr ty 1€ khung hinh ban dau

c. Position the picture in the center of the page (using the | c. Can anh gitra trang (str dung vi tri Middle Center) va
Middle Center position), and set the text wrapping to thiét 1ap ngat chir (text wrapping) kiéu Tight.

Tight.

d. Delete the empty paragraph mark near the top of the | d. Xda dau doan tréng (doan tréng) ngay canh anh.
picture.

e. Set the picture’s alt text title to The Princess and the alt | e. Thiét 1ap chir thay thé (alt text) cho anh v&i tiéu dé 1a The
text description to Photo of a young girl in a fancy blue Princess va mo ta la Photo of a young girl in a fancy
dress. blue dress.

42. | On the second page, set the position of the text box to Top | Trong trang thw hai, dat vi tri (position) hép chir tai Top

Right with Square Text Wrapping. Right with Square Text Wrapping

43. | Move to the end of the document; Di chuyén dén cubi tai liéu va thyc hién

a.

d.

Set the height of the scroll shape to 1” and the width to
3"

Drag the shape to the horizontal center of the page, just
after the end of the story.

Apply the Moderate Effect — Teal, Accent 5 style to the
shape.

Set the font size of the shape text to 24 points.

a.

Thiét |ap chiéu cao cGa hinh cudn gidy 1a 1” va chiéu
rong la 3”.
Kéo hinh ra gitra trang, dat sau phan két thac truyén.

Ap dung shape style kiéu Moderate Effect — Teal,
Accent 5

Thiét lap kich thwéc chi trong hop thanh 24pt

Part 5.3. Insert and format SmartArt graphics

- Create a SmartArt graphic

- Format a SmartArt graphic

- Modify SmartArt graphic content
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#

Task

Yéu cau

44,

Open the Word_5-3 document, and do the following:

M¢& tai liéu Word_5-3.docx va thuc hién:

a.

In the blank paragraph that follows the list, create a SmartArt
graphic based on the Basic Timeline layout.

Copy or enter the list items into the Text pane of the SmartArt
graphic. Remove any unused bullet points.

In the Text pane, at the beginning of the list, add a first-level
entry for Princess loses ball in pond.

In the SmartArt graphic, to the right of the last shape, add a
shape labeled The End!

Demote “Promises to love frog” and “Breaks promise” to
second-level items.

Change the layout of the SmartArt graphic to Basic Bending
Process.

Change the color scheme of the SmartArt graphic to Colorful
Range — Accent Colors 5 to 6.

Apply the Moderate Effect style to the SmartArt graphic.

a. Trong doan van ban trdng ngay sau danh sach cac

muc, tao SmartArt dwa trén bd cuc Basic Timeline

b. Sao chép (hoac nhép) cac muc trong danh sach vao

thanh Text pane cla SmartArt. Xéa cac hoa thi
khéng str dung.

. Trén thanh Text pane, bat dau cta danh sach mirc

1 la Princess loses ball in pond.

. Trong SmartArt, chén hinh cudi vao bén phai v&i noi

dung The End!

. Lui cap (Demote) Promises to love frog va Breaks

promise thanh danh sach cap

Thay d6i bd cuc cGa SmartArt thanh Basic
Bending Process.

. Dbi mau ctia SmartArt graphic kiéu Colorful Range

—Accent Colors 5 to 6.

. Ap dung style Moderate Effect cho SmartArt
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